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logical operations can be applied to it without
causing an error.

13. Interactive mode is a command line shell
which gives immediate response to each
statement, whereas Script mode is used to
write longer Python codes. Interactive mode
has three arrows >>> as prompt, whereas in
Script mode the prompt is .py.

14. The main difference between supervised
and unsupervised machine learning is that
supervised machine learning uses labelled
data while unsupervised machine learning
does not use such data.

15. (a) Buddy: It is a companion robot designed
to entertain the family. This endearing
emotional robot wins the heart of every
member of the family, including children
and adults. As a real companion, it can
walk around house like a pet.

(b) Sophia: It is a social humanoid robot
developed by Hong Kong-based
company Hanson Robotics. It is capable
of imitating human gestures and thus is
capable in answering questions. She has
been given official citizenship in Saudi
Arabia. The United Nations has given
her the title of Innovation Championship.
Sophia has appeared in several high-
profile interviews and appearances.

Cyber Olympiad
Choose the correct option.
1. (c) 2. (b) 3. (a)
4. (d) 5. (d) 6. (a)
7. (b) 8. () 9. (b)
10. (¢) 11.(b) 12.(b)
13.(¢) 14.BYRE 15.(d)
16.(d) 17.(d) 18.(d)
19.(¢) 20.(a) 21.(b)
22.(d) 23.(d) 24.(d)
25.(a)
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Computer Virus
X ctivity Time
1. MV 2. BV 3. PV
Drag & Drog

4. TH 5. W 6. MRV
7. PV 8. TH 9. PV
10. MRV

Brain Teager

1.

The full form of VIRUS is Vital Information

Resources Under Seize.

The first virus to ever be identified was known as
the Creeper.

3. Acid Rain is an example of Program Viruses.

4. Worms generally spread through e-mails and

networks.

Let's Review

. Tick (v) the correct option.

1. (c) 2. (a) 3. (o)
4. (a) 5. (¢)
Fill in the blanks.

1. A virus can destroy files, software and
program applications.

2. A virus can reproduce itself without any user
action.

3. Macro viruses infect files that are created
using certain applications or programs.

4. Stoned virus is an example of Boot viruses.

5. Commwarrior was the first known cell phone
virus.

6. You can prevent virus infections by using
Antivirus software.

7. Memory Resident virus get control over the
system memory.

Answer the following questions.

1. Acomputervirusisatypeofcomputerprogram
that has replicating capabilities. When
executed, it replicates itself by modifying
other computer programs and causing loss
of data.

2. Some of the sources of computer virus are:
Internet, Email attachments, computer
network removable devices and Bluetooth
transfer

3. We can know that our computer is attacked
by a virus by following symptom:s:

» The computer runs very slow and it takes
along time to start.
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e The infected file may make copies of Number System
itself. A copy of such a file may be sent to

. . rain Teager
all the addresses in your e-mail address 8

list. 1. 0011 2. 0111
«  The virus may reformat your disk drive | 3- 1011 4. 1110
and delete your files and programs. E ctivity Time
. Thi viru§ mzy ir}stall hidden programs, | 1 74+0=9 2 0%0=0
t t .
suc a.sp1rae software . 3 041=1 " 1x0-0
* The virus may reduce security.
. . . 5. 1+0=1 6. 1x1=1
¢ Windows will not start because of missing 3 3
certain critical system files. 7. 1+1=10 8. 1x1=1
4. A computer worm is a type of malware that Rapid Fire

has the self-replicating ability. The primary | 1. You can perform calculations on binary number.
function of worms is to self-replicate and | 2. The hexadecimal number system has the base 16.
infect other computers while remaining 3

: X . The binary number system consists of two digits,
active on infected systems.

1.e., 0 and 1 and has the base 2.

5. We can prevent a computer from virus | 4 The octal number has the base 8.
infection by following these steps. . .
I ctivity Time

e Install an antivirus software from a well-

known and reputed company. Update | I- (@) 1 1
and use it regularly. + % (1) %
¢ Do not install pirated software. 1 1.0 0
* Scan removable devices like CD or a pen b
drive received from another person. (b) 1 i ) (1) 0
¢ Scan files downloaded from the Internet. T 111 0
6. Antivirus is a kind of software used to 1 01 0
prevent, scan, detect and delete viruses from © 1 1 1 1 1
a computer. L1 0101
7. Some popular antivirus software are: Quick 0.0 1 11
Heal Total Security, McAfee Antivirus, 0 1.1 0
Kaspersky Antivirus, Norton Antivirus, (d) 1 1
AVG Antivirus, Avast Antivirus, Trend 1 1 0 1
Micro Antivirus, and Maximum Security. 1 0 1
peaking in the microphone. The voice starts 1 01 1 0
recording. 2. (a) 1 1 1
P ctivity Time X i % %
The students will do it themselves. + 1 1 1
, + 1 1 1
Brain Teager 1 1 1 0 0 1
L. |C|R[E|O|P[E[R]
(b) 11 0
2. |[RIE[L[A]X] x 1.0
0 0 O
3. M|E[M[O|R|Y||R[E[s|1|D|[E|N]|T| + 110
1 1 0 0

tlrlofr{z]a|N][H][O[R[S|E]




(c) 1 0 1 0 4. A string is a sequence of characters written
X 1 0 1 one after another. It can have letters, numbers,
+ 0 (1) 8 (1) 0 symbols and even spaces. For example, 26T5
10 1 0 isastring of 2, 6, T'and 5.
1 1. 0 0 1 0 5. A system that represents or expresses
numbers is called a number system. The most
(d) 10 1 1 commonly used number systems are decimal
a i (1) (1) } number system, binary number system, octal
£ 00 0 0 number system, and hexadecimal number
1 0 1 1 system.
1 1. 0 1 1 1 6. A number system which has its base as 8
is called an octal number system. It uses
3. (a) 1001 =1x23+0x22+0x21+1x20 numbers from 0 to 7. For example, 5249 and
=8+0+0+1 72
=9 7. To convert a decimal to a binary number,
() 1100 =1x23+1x22+0%21+0x 20 follow the steps given below:
Q444040 » Divide the given decimal number by 2. It
_ 1 gives the result along with the remainder.

 If the given decimal number is even, the

4. (a) Dividing 232 by 16, we get quotient 14 and result will be whole and the remainder 0.

remainder 8.  Ifthe given decimal number is odd, it will

Thus, (232)16 = E8. not be divided properly and it gives the
(b) Dividing 111 by 16, we get quotient 6 and remainder 1.

remainder 15.  Placing all the remainders in such a way

Thus, (111)16 = Fé6. that the least significant bit is at the top

and most significant bit at the bottom.

5. The complete table is given below. i i )
The number so obtained is the required

Decimal | Binary Decimal | Binary binary number.
0 0000 4 0100 More on Flash
1 0001 5 0101 I ctivity Time
) 0010 6 0110 Components of Flash w1ndow are circlreflﬁi?ﬁle grid.
Alclylolp N|s
3 0011 7 0111 = ST e S R SR S A S
TIBIS|T|A D|C
Let's Review I I|L|X|Y QK
A. Answer the following questions. M T HIM|E S| K
1. Binary data is a type of data that can be E|(V|L|I|B|R|A|R|Y|H
represented in the binary numeral system. :L U NH M LM I K v
2. An analog computer uses a continuous signal L plwiTlololLs|] |1
to process, whereas a digital computer uses a S 5
discrete signal for its operation. N{F|L|J|P|T |G H|FE
3. A number system with its base as 8 is called E|B|O|C|O|L|O|R|S|W
an octal number system. It uses numbers EIM|E|N|U|J|F|ID|F|C

from 0 to 7.
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Ectivity Time
The complete labelled picture is given below.
Show/Hide layer r Lock/Unlock layer

Untitled-2*
= Scerle 1
L &&0 5 10 15 20 2 30 35 %0
I P Layer1 I

il @ b @l W G 1 [20fs [ 00s <] n

I
Insert |—Delete layer

|
L
layer ayer

Let's Review
A. Tick (V) the correct option.

1. (b) 2. (¢ 3. (a)
4. (b) 5. (¢)
B. Write T for true and F for false for the following
statements.
1. F 2. F 3. T
4. T 5. F 6. T

C. Answer the following questions.

1. Flash is an animation software which can be
used to create animations, games, cartoons,
websites, graphic effects, text effects and
special effects. It is one of the most popular
technologies on the Internet.

2. Timeline is a feature of Flash which is used to
create or edit animations. It contains frames
which play an important role in making
animations.

3. The Pen tool used for many purposes such as
to draw precise paths, such as straight lines or
smooth flowing curves.

4. Steps for using the Pen tool:
*  Click the Pen tool from the Tool box.
e Click the Stage to set the first anchor
point.

» Click another point to set second anchor
pointof the Stage. Flash will automatically
connect both the anchor points.

e Click again to set more anchor points on
the stage.

 Position the Pen tool over the first anchor
point and click it. Flash automatic adds a
fill once the path becomes a closed outline.

5. Steps to import a picture in Flash:
* Click the File menu. A menu appears.
» Point to Import option. A menu appears.

* Click the Import to Stage option. The
Import dialog box appears.

» Select the picture and click the Open
button.

The image will be added to the Stage.

6. Free Transform tool can be used to increase
or decrease the size of objects, move and
rotate objects.

7. In animation, alayeris made up of many small
rectangles which are separated by lines. Such
small rectangles are called frames and lines
are called framelines. Each frame contains a
single image in sequences of images, which
when played together create animation.
A keyframe is a frame where a new object
appears in the Timeline.

8. A motion tween is a type of animation that
uses symbols to create movement, size and
rotation changes, fades, and colour effects.

9. In Flash, the Break Apart option is used to
break text into individual characters.

10.In Flash, symbols are used for creating
animations. Objects that we draw in Flash
can be converted into symbols which help in
creating animation in easier way.

Brain Teager

1. |F|R|A|M[E]S]

2 [FIRJEJE][T[R[A[N]S|F]O[R|M]
;

s [s|T|AalG|E]|
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I ctivity Time

1. Options tool, Circle tool, Pen tool, Eyedropper
tool

2. Rectangle tool, Circle tool, Eyedropper tool

3. Options tool, Circle tool, Pen tool, Color tool

4. Rectangle tool, Pen tool

Drag & Drop



More on HTML
Ectivity Time
HTML tags and attributes used to design the given

page are:
1. <html> 2. <head>
3. <title> 4. <body>
5. <h1> 6. <hr size=8 width=100%
7. <color> 8. <p>

Ectivity Time
HTML tags and attributes are circled in the
alongside grid.

D|A|H P|JIN
HIE|T LIE|O
T|C|A K| QW
M| A|L EI|R| T
L|s|1 PlY|D
Bl1]G R|W|T
B|Z|N O|X|H
O|E|X W|T|U
DiQ|Y S|IV|]
Y|L|F| R|I|H
Rapid Fire

1. HTML stands for HTML stands for Hyper
Text Markup Language.

2. Font tag is used to change font size

3. The BACKGROUND attribute of the <body>
tag is used to place an image as a background.

4. <hr> tag is used to draw a horizontal line on the
web page.
Let's Review
A. Tick (V) the correct option.

1. (¢) 2. (a) 3. (a)
4. (a) 5. (a) 6. (b)
B. Name the following tags.
1. Empty tag 2. Underline text tag
3. Image tag 4. Anchor tag
5. Italic text tag 6. Bold text tag
C. Write T for true and F for false for following
statements.
1. F 2. F 3. T
4. T 5. T 6. T

D. Answer the following questions.
1. HTML, stands for Hyper Text Markup

Language, is a standard markup language for

Drag & Drog '@'

creating web pages to display on World Wide
Web. Web pages are text documents which
have HTML commands with an extension
.html. HTML is a character-based method
for describing and expressing the controls of
a document. The content may be pictures,
text, sound, etc.

2. The 'hr' tag in HTML stands for horizontal

rule with syntax <hr>. It is used to insert a
horizontal rule on the web page to separate
different parts of the text from one another. It
is an empty tag and it does not require an end
tag.

3. Tochange the size and the width of horizontal

line, type the HTML codes given on the
next page and see the output on the Internet
Explorer.

<html>

<head>

<title> HTML </title>

</head>

<body>

<h1>HTML </h1>

<hr size=10 width=100%>

<p>HTML stands for Hyper Text Markup
Language. It is a markup language that is
used for creating web pages to display on
World Wide Web. </p>

</body>

</html>

4. We use the BACKGROUND  attribute

of the <body> tag to place an image as a
background. For it, type the HTML codes
given below and see the output in Internet
Explorer.

<html>

<head>
<title>DOLPHIN</title>
</head>

<body>

<body background="D:\My work\
dolphins.jpg"/>

</body>

</html>

5. Ahyperlink, or simply a link, is a word, group
of words, or image that the user can click on
to jump to another document. When the user

.7 Keys



moves the cursor over a link in a web page,
the arrow will turn into a little hand.

. An anchor tag (<a>) is a feature in HTML

which defines a hyperlink. It is used to link
one page to another.

. HREF (Hypertext reference) is an attribute

of the anchor tag used to create a link to
another page, whereas BGCOLOR attribute
is used for coloring the background of the
document.

. To create a link on a web page, type the

HTML codes given below and see the output
in Internet Explorer.

<html>

<head>

<title> DOLPHINS </title>

</head>

<body>

<h1><font size="25"> DOLPHINS </
font></h1>

<hr size=15 width=100% color=Blue>
<p>Dolphins are actually marine
mammals. These amazing marine animals
belong to the cetacean family, which also
includes whales and porpoises. Dolphins
are extremely intelligent and playful
animals. </p>

<a href="D:\My work\dolphin.jpg">
Click here to see picture of dolphin</a>
</body>

</html>

P ctivity Time

The complete crossword is given below.

Keys "
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Model Test Paper — |

A. Tick (V) the correct option.

1.
5.
9.

(d) 2. (a) 3. (b) 4. (b)

(c) 6. (c) 7. (¢) 8. (a)
(a) 10. (d) 11.(a) and (b)

B. Fill in the blanks.

1.

[ NS I N

=

8.

Viruses are written by programmers called
software.

Amoeba. A is an example of Program virus.
Boot virus is also known as Boot Sector Virus.
A group of four bits is called nibble.

A string is a group of characters written one
after other.

The Text tool is used to write text on the Stage.

Frmelines are used for creating animations in

Flash.
The Font tag is used to format a set of text.

C. Answer the following questions.

1.

&

Some computer viruses are: Amoeba.A, Acid
Rain, Crazy.A, Relax, Melissa.A, Bablas,

Zeus, Netbus, Elkern, Marburg, Satan Bug
and Tuareg.

Some of the sources of computer virus are:
Internet, Email attachments, computer
network removable devices and Bluetooth
transfer

Boot Sector Virus is a type of virus that infects
the parts of the computer called the system
sector or the Master Boot Record (MBR) of
hard disks.

Binary data is a type of data that can be
represented in the binary numeral system.

A number system which has its base as 8
is called an octal number system. It uses
numbers from 0 to 7.

Pen tool is a type of tool that is used to draw
precise paths, such as straight and curved
lines.

Steps to import a picture on the Stage:

*  Click the File menu. A menu appears.

» Point to Import option. A menu appears.

* Click the Import to Stage option. The
Import dialog box appears.

» Select the picture.

» Click the Open button. The picture is
opened on the Stage.

Drag & Drop



8. Layers are a utility of Flash that helps in
organizing animation work (sheets) as a stack
in the form of layers one over the other.

9. Steps to insert a keyframe on timeline:

e Select the
Timeline.

desired frame from the

*  Click the Insert option. A menu appears.

e Point to Timeline and click the Keyframe
option.

The keyframe gets inserted at the desired

place.

10. An anchor tag (<a>) is a feature in HTML
which defines a hyperlink. It is used to link
one page to another.

* Open the Control Panel and click the
Clock and Region link. Date and Time
dialog box appears.

* Click the Change time zone option. A
dialog box appears.

e Click the Change date and time button.
The Date and Time Settings dialog box
appears.

¢ Make the required changes in date and
time of your system and click the OK
button.

11.To create a link on a web page, type the
HTML codes given below and see the output
in Internet Explorer.

<html>

<head>

<title> DOLPHINS </title>

</head>

<body>

<h1><font size="25"> DOLPHINS </
font></h1>

<hr size=15 width=100% color=Blue>
<p>Dolphins are actually marine
mammals. These amazing marine animals
belong to the cetacean family, which also
includes whales and porpoises. Dolphins
are extremely intelligent and playful
animals. </p>

<a href="D:\My work\dolphin.jpg">
Click here to see picture of dolphin</a>
</body>
</html>

Drag & Drog

About Tags in HTML
I ctivity Time
The students will do it themselves.
I ctivity Time

The names of tags and attributes used to

tables in HTML are encircled in the grid..

D|B|O|R|D|E|R|C
W|G|V|W|Y|X|Z|E I
X|E|E|F|U|J|T|[L|R|Z
FlJ|K|I|H|Z|S|L|LJA
A|C|B|D|A|K|Y|P|X]|L
G|C|E|L|L|S|P|A I |
H|A|B|U|V|T|A|D|B|G|C|D
I [P|C|M|P|L|Q|D|T|N|O|U
F|T|D|N|s|R|W[I|D|T|H]S
D|I|O|C|I|J|E|IN|L|[N|M|K
Z|O|G|H|B|P|B|G|C|O|A|Q
Y|N|B|G|C|O|L|O|R|R|H]|]
Rapid Fire

1. An unordered list is also called a Bulleted list.
2. The Type attribute can take three values.

3. The Start attribute allows you to specify the
starting point of the numbering scheme.

4. In definition list entries do not have number or
bullet in front of them.

Let's Review

A. Tick (V) the correct option.
1. (a) 2. (b) 3.
4. (a) 5. (b) 6.
B. Name the following.
1. Unordered listtag 2. Listtag
3. Ordered list tag 4. Definition list tag
5. Table tag 6. Table header tag
7. Table row tag

C. Name the attributes for the given functions.
1. bgcolour=#rr/gg/bb 2. valigh=/bottom
3. <tr>tag 4. align=/bottom
5. height=n/n% 6. align=left

D. Answer the following questions.

1. InHTML, anested list is alist within another
list. It means one list can be placed inside of
another. For example, the user can nest an

@ -
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ordered list within an unordered list, and vice
versa.

. A definition list is a list of terms and

corresponding definitions. Thatis, adefinition
list is used to build a list of definitions. The
tags used for creating a definition list are:
<dl> for definition list, <dt> for definition
list term, <dd> for definition list explanation.

To create a definition list, the HTML code is

given below.

<html>

<head>

<title> Creating Definition List</title>
</head>

<body>

<dI>

<dt>Photosynthesis</dt>
<dd>Photosynthesis is a process used
by plants and other organisms to convert
light energy, normally from the sun, into
chemical energy that can be used to fuel the
organisms' activities.</dd>
<dt>Keyboard</dt>

<dd>A keyboard is the set of typewriter-
like keys that enables you to enter data
into a computer. Computer keyboards are
similar to electric-typewriter keyboards
but contain additional keys.</dd>
<dt>Mouse</dt>

<dd>A computer mouse is an input device
that is most often used with a personal
computer. Moving a mouse along a flat
surface can move the on-screen cursor to
different items on the screen.</dd>
</dl>

</body>

</html>

See its output in the Internet Explorer.

. The main difference between an unordered

list and an ordered list is that in an unordered
list, the items are not displayed in a specific
order; while in an ordered list, the items are
displayed in a specific order.

. The <ol> tag has two main attributes: Type

and Start.

. Tables are the most important utility in

HTML. Using tables, we can modify complex

and bulky data easily understandable for the
web page visitors.

6. In HTML, BORDER COLOR is used to
colour the border of a table, while BG Color
is used to apply background colour to the
table.

7. Cell spacing means the amount of space
between the cells in a table.

CEEEA® Microsoft Access

I ctivity Time
The Access window with labelled components is
given below.

Quick Access Toolbar
File Button

Title1 Bar

Tabbed Document

»—Navigation Pane

I ctivity Time

Words representing datatypes are circled in the grid
given below.

A/H|T|E|X|T|F|A[E|D
uly|1]1]c|Llo[LIE|L
TIMIE[K[C|P[O]s ][O
O|Z|A|C|X|U[A|O|L|G:
N|U|M|B|E|R|T|K|S|T:
ulp|E|la|V|RrR]V|U|Q|C
M|u|[M|w|B[E|B[P|O[A]
B|E|O|F|H|N|R|N|C|L
E|T|K|J|I|CM|N|P|R
RIDJ/A|T|E|Y M| B|Q|O

Rapid Fire

1. Computerised library system and flight

reservation system are two database applications.
2. FoxPro and Microsoft Access DBMS software.

Drag & Drop
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. Database View makes it easy to enter data in
tables.

. All database objects appear in Navigation Pane.

Let's Review
. Tick (v) the correct option.

1. (¢) 2. (b) 3. (a)
4. (b) 5. (d) 6. (a)
. Fill in the blanks.

1. Database is a collection of data related to each
other.

2. Atable organises data into rows and columns.

3. RDBMS datais structured in database tables,
fields and records.

4. The Navigation Pane is the area on the left of
the window and displays database objects.

5. A database file created in MS Access has a
DOS extension of .mdb.

6. A primary key is a field which identifies each
record in a table.

. Write T for True or F for False statements for the

following statements.
. T 2.T 3. F 4T 5

. Answer the following questions.

1. DBMS, stands for Database Management
System, is a software that allows users to
define, create and maintain a database and
provides controlled access to the data. ATM
and flight reservation systems are two DBMS
software.

F 6T

2. A database contains four objects: table,
query, form and report.

3. RDBMS data is a management system which
1s structured into database tables, fields and
records.

4. MS Access is one of the most popular and
powerful RDBMS which comes as an integral
part of the MS Office suite of application. It is
widely used to organise and manipulate data
in an efficient manner.

5. The two ways of creating a database are:
By using a blank database and By using a
template.

6. The entries contained in a record are stored
in its columns known as fields. Reports are
designed to recall data and display it in an
easy-to-read format for printing.

7. A primary key is a field which uniquely
identifies each record in a table. It is also used
to establish a relationship between tables to
link them together.

8. Steps to sort data in the table:

*  Open the table in Datasheet View.

» Click the arrow on the right of the column
header you want to sort out.

e Click the Sort A to Z to sort data in
alphabetic ascending order.

e Press the OK button. The data will be
arranged in alphabetic ascending order as
shown.

9. Steps to filter data:
e Select the column.

»  Click the arrow on the right of the column
header.

e Clear Select All check box.

» Select the items you want to display in
your datasheet.

e Press the OK button.

I ctivity Time

1. Table 2. Table Design
3. View 4. Filter
5. Property sheet 6. Text

Introduction to MS Publisher 2010
X ctivity Time

NENIE

N N OO

O

It allows you to store data in a database.

It helps you to create dynamic publication in
a very little time.

It has much better spell checker than other
DTP software.

It is used to create worksheets.

You can create presentation using this
software.

It has a lot of editing tools for typesetting of
books.

It offers a new object alignment technology.

It is used to develop web pages.

.7 Keys
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1. MS Publisher is a desktop publishing
application which can be used to create and
design professional looking documents such as
newsletters, brouchers, fly ero, business cards,
website, and many more.

2. Yes

3. Yes

4. No. MS Publisher is a desktop publishing

Keys "

application which is different from MS Word
because MS Word is a software which manly
works for word processing.

Let's Review

. Tick (V) the correct option.

- (b)
- (b)
- (a)
- (0)
- (d)

Answer the following questions.

1. MS Publisher is a desktop publishing
application which help us create and design
professional documents such as newsletters,
brouchers, flyers, business cards, website,
and many more.

Ul BN

2. The main tools available in MS Publisher
window are: the Title Bar, the Quick Access
toolbar, the Ribbon, the Page Navigation
Pane, the Publication Page area, and the
Status Bar. The Status bar also contains the

Page Layout View buttons and the Zoom
Slider.

3. Follow these steps to publish a document on
the web:

e Start Microsoft Publisher and open the
page you want to convert.

e From the File menu, select Create Web
Site from Current Publication. A dialog
box appears.

e Click the Yes option selecting all pages.
Make changes as needed.

e Select the Yes option when the Design
Checker Download Time dialog box
opens.

» Click the OK button when the design
check is complete. Make changes to the
web page.

Select Web Properties from the File menu
and create the title of the page and other
information.

e Select Save As HTML from the File

menu and click the Save option.

. Formatting the publication means to change

the fonts and colours of the publication.

. Steps to change Font Schemes:

e Start the MS Publisher 2010.

* Click the Page Design tab and click the
Font button. A dialog box with different
fonts opens.

¢ Select the font scheme from the palette
and click it. The select font will be applied
to your document.

. In MS Publisher, the Picture tools tab helps

us edit, modify, crop or change pictures.

. Brightness, Contrast, Recolor, and Compress

Pictures. The Recolor tool has many options
such as Quickly change a picture to shades
of a single color, More Variations, Set
Transparent Color, and Restore the picture's
original colors.

. Steps to insert a picture:

e Start the MS Publisher 2010.
e Click the Insert tab.

» Click the pictures command button, say
Clip Art button from Illustrations group.

 Inthe Insert Picture dialog box, browse to
find the picture that you want, and then
select it.

e Click the arrow next to Insert, and then

click Link to File.

» Click the required picture to insert it in
your publication.

The selected picture will be inserted in the
publication.
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Introduction to Adobe Photoshop
Ectivity Time

The labelled Photoshop window is given below.

Document

C Workspace
window

switcher

Application Bar

History Palette ——
Tools Palette

Navigator Palette ——

Properties Palette ——

Layer Palette ———

Mini Bridge :
s Color Palette —™:=——1=

i e

Rapid Fire

1. PhotoWorks can be used for editing images.
2. Move Tool is used to move selected image
3. Type Tool is used to add text.
4

. Erase Tool erases a part of an image.

Let's Review
A. Tick (V) the correct option.

1. (¢ 2. (b) 3. (b)
4. (¢

B. Name the tools.
1. Crop Tool 2. Gradient Tool
3. Erase Tool 4. Magic Tool
5. Type Tool 6. LassoTool

C. Answer the following questions.

1. 'We use Photoshop for many reasons such as:
*  We can create and edit images or picture
using 1t.
*  We can use it for web designing.
*  We can alos use it to create special effects
and optimize digital images.
2. Steps to start Photoshop program:
e Open Photoshop.
*  Click the File tab.

Drag & Drog '@'

Click the New option. The New dialog

box appears.

Specify  Name, Size, Resolution,
Background Contents, and Color.

Click the OK button.

. Here are three uses of Photoshop:

Photoshop can be used to combine
different image elements such as
photographs, scanned art, text, etc. It can
save them as a digital image.

It can be used to edit digital photographs
by making subtle changes, such as
adjusting the colour in a scanned
photograph.

It can apply colours or patterns to your
images with different brush styles.

. Steps to select an irregular-shaped area:

Click the File tab.

Click the Open option. The Open dialog
box appears.

Select the file to be opened.

Click the Open button. The required
image gets opened.

Right-click the Marquee selection tools
and select the desired Marquee tool.

Drag the mouse over the image to select
the required area.

. Tool Palette is a utility of Photoshop. It

provides users with various tools, which
he/she can use while working on images. In
Adobe Photoshop CS6, there are about 70
tools in Tools palette.

. Crop means to cut short some part of an

image. The Crop tool enables the user to crop
the image. Here are the steps to used to crop
an image.

Click the File tab.

Click the Open option to open the image
to be cropped.

Click the Crop tool.

Click and drag to select the portion of the
image to be cropped and press the Enter
key.

The selected portion gets cropped.
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7. Steps to open Photoshop file
*  Click the File tab. A menu appears.

» Click the Open option. The Open dialog
box appears.

e Select the location of the file from the
Look in box.

¢ Select the desired file and click the Open
button.

Brain Teager

1. Lasso Tool

3. Eyedropper Tool
K ctivity Time
Names of Photoshop tools are circled in the below
grid.

2. Magic Tool
4. Zoom Tool
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More About Python

Rapid Fire

1. In Python, the output of: print("50%5") is 50%5.
2. false

3. The name of operator !=is 'is not equal to".

4

. false

Let's Review

A. Tick (V) the correct option.
1. (b) 2. (¢) 3.
4. (d) 5. (a), (b)and (c)
B. Fill in the blanks.

1. In Python, the iterative statements are also
known as looping statements.

(b)

2. The while loop is used to execute a block
of statements repeatedly until a given a
condition is satisfied.

3. The operator 'and' is a logical operator.

4. The 'if statement' allows you to evaluate if a
certain condition is met.

C. Write T for true statements and F for false
statements.

1. F 2. T 3. F 4. F
D. Answer the following questions.

1. Python language is used for various purposes.
Some of them are given below.
in  games

e Python 1is very helpful

development.

e Itis widely used in scientific and numeric
computing.

 Itis helpful to perform multiple tasks.

e It can be used to develop multimedia
applications.

e It can be used to develop different
applicationslike webapplications, graphic
user interface based applications, software
development  applications,  scientific
and numeric applications,
programming, and 3D applications. It
makes an interactive interface and easy
development of applications.

network

e Python is the most popular language
for Artificial Intelligence and machine-
learning projects where machines can
mimic human behaviour and most of
the human work is being automated by
machines.

« Applications of Python programming in
education has a huge scope as it is a great
language to teach in schools or even learn
ourselves.

2. In Python, operators are special symbols that
carry out arithmetic or logical computation.

Arithmetic Operators are used to perform
mathematical calculations like addition,
subtraction, multiplication, division and
exponential.

Relational operators compare the values on
the left and right side of the operator and
return the relation as either True or False.

Logical operators are used to combine two
or more relational expressions and return
a single value as a True (non-zero) or False
(zero).
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3. The main difference between the for loop
and the while loop is that: the for loop is
used to execute a block of codes in sequence
until the condition in the for statement is no
longer valid; whereas the while loop is used to
execute a block of statements repeatedly until
a given a condition is satisfied.

4. Conditional utility  of
Python, which are used to perform actions
or calculations based on whether a condition
evaluates to true or false. There are three
types of conditional statements in Python: If
statements, If ... else statement, and If ... elif
... else ... statement.

statements are

5. An assignment operator is basically a binary
operator that helps in modifying the variable
to its left with the use of the value to its
right. We utilize the assignment operators to
transform and assign values to any variables.

Artificial Intelligence
Rapid Fire

1.

Drag & Drog

Unsupervised machine learning does not need
any labelled data to perform a task.

The three virtual personal assistants are: Cortana,
Alexa and Siri.

Types of supervised machine learning are:
classification and regression.

The two types of unsupervised machine learning
are: clustering and association.

Let's Review

. Tick (v) the correct option.

1. (c) 2. (o) 3. (b)
4. (¢) 5. (¢)

. Fill in the blanks with the correct words given

below.
1. Sophia is a citizen of Saudi Arabia.

2. Sophia is a humanoid designed by Hong
Kong-based company.

3. Alexais a virtual personal assistant.

4. Regression is the problem of predicting a
continuous quantity output for an example.

5. Romeo is a human-sized robot that has been
designed to assist the elderly people.

C. Write T for true and F for false statements.

1. F
4. F

2. F
5. F

3. T

D. Answer the following questions.

1. In the present day time, artificial intelligence
technology is being used by banks and other
financial institutions for many purposes
such as improving customer service through
the use of virtual assistants or credit scoring
to correctly determine a borrower’s risk.
Artificial intelligence is fighting a battle
against fraud and money laundering in
banking sector.

2. Artificial intelligence has proved a boon in
the health sector. The primary aim of health-
related artificial intelligence applications is to
analyse relationships between prevention or
treatment techniques and patient outcomes.
Artificial intelligence programs are applied
to practices such as diagnosis processes,
treatment protocol development, drug
development, personalized medicine, and
patient monitoring and care. At the time
of pandemic disease Covid-19, artificial
intelligence had played a vital role in
thermal imaging in airports and elsewhere.
It is helping recognise infection from
computerized tomography lung scans. It has
also been used to provide data to track the
spread of the disease.

3. Three uses of artificial intelligence in teaching
and learning:
(a) It is simplifying administrative tasks by
reducing the teacher's effort like assessing
students' work and grading exams.

(b) It is helping school admission boards by
automating classification and processing
of paper work.

(c) It is helping students with immediate
feedback and stops them in their tracks
if they are straying and improves their
understanding of the subject.

4. A robot is a human-shaped machine that can
execute specific tasks with little or no human
intervention and with speed and precision.

5. A chatbot is a computer program that
simulates human conversation through
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voice commands or text chats or both, | C. Answer the following questions.

through techniques. An artificial intelligence
powered chatbot is basically an attempt to
recreate a human. Some examples of chatbot
technology are Google Assistant, Cortana,

Alexa, Siri, Watson and messaging apps,
such as WeChat and Facebook's Messenger.

6. Google Assistant is a virtual assistant that can
engage in two-way conversations, whereas
Cortana is a voice-enabled virtual assistant
that helps Windows 10 users initiate requests,
complete tasks and anticipate future needs by
surfacing relevant data in a personal context.

P ctivity Time
The students will do it themselves.

Model Test Paper — Il
A. Tick (V) the correct option.

1. (d) 2. (¢ 3. (a) 4. (¢
5. (b) 6. (a) 7. (c) 8. (b)
9. (a) 10. (b) 11.(b) 12.(b)
13.(a) 14. (a) 15.(c)

B. Writethedescriptions of the following attributes.

Attribute Description

This attribute aligns
Align=left/centre/ |the table to the left,
right right or centre of
the web page.

This attribute adds
Bgcolor=#rrggbb a background
colour to the table.

This attribute adds
Bordercolor=#rrggbb | a colour to the
table's border.

This attribute
defines the distance
Cellpadding=n between a cell
boundary and its
contents.

This attribute adds
space between cells.

This attribute
Width=n/n% defines a minimum
width of the table.

Cellspacing=n

1.

An unordered list, a bulleted list, is a list of
items that is used when the items in the list
are not to be displayed in a specific order.

The Type attribute helps us in selecting
numbers, letter, or Roman numerals to give
anumbering scheme.

To create border on a table, type the HTML
code as given below and see the output in
Internet Explorer.

<html>

<body>

<table border="1">
<tr>

<td>row 1, cell 1</td>
<td>row 1, cell 2</td>
</tr> <tr>

<td>row 2, cell 1</td>
<td>row 2, cell 2</td>
</tr> </table>
</body> </html>

A database is a collection of information that
is organised for easy access, management and
updating.

Microsoft Access, dBase, Visual FoxPro,
IMS and Oracle, MySQL, SQL Server and
DB2 are some examples of DBMS.

Steps to create a database using template:
* Click the Sample Templates from
Available Templates.

» Select the database desired by you such as
‘Students’ from the Available Templates
pane.anywhere in the world.

* Click the Create button.

Some features of MS Publisher 2010 are:

* MBS Publisher 2010 has advanced editing
tools including the ability to pan, zoom
and crop images with pictures placeholder
which has the ability to move picture on
the page.

 New object alignment technology by
which we can align and position the
contents easily.

e It helps to create dynamic publications
in very little time when you insert and
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customise prebuilt building blocks of
content.

e It gives your text the appearance of
expert typesetting with new Open Type
typography.

e It provides support for the ligatures,
stylistic sets and other professional
typography features available in many
Open Type fonts.

¢ It has much better spell check feature for
error free publication.

8. Steps to create a publication:

» Choose any type from the most popular
task pane. For example, Business Cards.

¢ Scroll and choose the type of design for the
publication from the designs displayed.

*  Click the Create button.

Print publication will be created and

displayed on the window.

. Tool Palette is a utility of Adobe Photoshop.

It provides users with various tools, which
he/she can use while working on images. In

Adobe Photoshop CS6, there are about 70

tools in Tools palette.
10. The syntax to the for loop in Python is:
for bariable in sequence: Loop statement

11. Robotics is a branch of computer science that
involves the conception, design, manufacture
and operation of robots. Artificial intelligence
is the brain of robotics. The main aim of the
robotics field is to create intelligent machines
that can assist humans in a variety of ways.

Robotics in widely used in many fields like
banking, gaming and healthcare.

Cyber Olympiad
Choose the correct option.
1. (a) 2. (b) 3. (¢
4. (d) 5. (b) 6. (d)
7. (d) 8. (¢ 9. (¢
10.() 11.(c) 12.(a)
13.(a) 14.(b) 15.(a)
16. (b) 17.(c) 18.(a)
19.(d) 20.(d) 21.(a)
22.(b) 23.(a) 24.(c)
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